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SCC-ACCO1 Accelerometer Input
Module

The SCC-ACCO1 accelerometer (ACC) input module accepts an active
accelerometer input signal, passes it through a 0.8 Hz highpass filter,
amplifies it, and then passes it through a 19 kHz lowpass Bessel filter and
an output buffer. The module has a fixed gain of 2, so the maximum input
range is 5 V. The SCC-ACCO1 also provides a 4 mA current source for
accelerometer excitation.

Conventions

The following conventions are used in this guide:

<> Angle brackets that contain numbers separated by an ellipsis represent
a range of values associated with a bit or signal name—for example,
P0.<3..0>.

» The » symbol leads you through nested menu items and dialog box options

to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.
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This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

When symbol is marked on a product, it denotes a warning advising you to
take precautions to avoid electrical shock.

When symbol is marked on a product, it denotes a component that may be
hot. Touching this component may result in bodily injury.
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bold

italic

monospace

SC-2345

SCC

Bold text denotes items that you must select in software, such as menu
items and dialog box options. Bold text also denotes parameter names.

Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard. This font is also used for the proper names of disk drives, paths,
directories, programs, subprograms, subroutines, device names, functions,
operations, variables, filenames, and extensions.

SC-2345 refers to both the SC-2345 connector block and the SC-2345 with
configurable connectors.

SCC refers to any SCC Series signal conditioning module.
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What You Need to Get Started

To set up and use the SCC-ACCO1, you need the following items:

U SC-2345/2350 with one of the following:
— SCC-PWRO1
—  SCC-PWRO02 and the PSO1 power supply

—  SCC-PWRO03—requires a 7 to 42 VDC power supply
(not included)

One or more SCC-ACCO1

SCC-ACCOI Accelerometer Input Module User Guide

Read Me First: Safety and Radio-Frequency Interference
SC-2345/2350 User Manual, available at ni . com

SCC Quick Start Guide, available at ni . com

SC-2345 Quick Reference Label

68-pin E Series DAQ device, documentation, and 68-pin cable
1/8 in. flathead screwdriver

Numbers 1 and 2 Phillips screwdrivers

Wire insulation strippers
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NI-DAQ (current version) for Windows 2000/NT/XP/Me

@ Note Software scaling of measurements is not supported on the Macintosh operating
system.
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Device Specific Information

@ Note For general SCC module installation and signal connection information, and
information about the SC-2350 carrier, refer to the SCC Quick Start Guide, available
for download at ni . com/manuals.

Installing the Module

A Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires.

You can plug the SCC-ACCO1 into any analog input socket on the
SC-2345. It can function as a single-stage module or as the first stage of
a dual-stage signal conditioning configuration. The socket you choose
determines which E Series DAQ device channels receive the SCC-ACCO1
signals, as explained in the Connecting the Input Signals section.

For single-stage input conditioning, plug the SCC-ACCO1 into any socket
J(X+1), where X is 0 to 7, and connect the input signals to the module as
described in the Connecting the Input Signals section.

If you use the SCC-ACCOLI in a dual-stage configuration, the SCC-ACCO1
must be the first-stage module. Plug it into any socket J(X+9) and plug the
second-stage SCC into socket J(X+1), where X is 0 to 7. Connect the input
signals to the SCC-ACCO1 as described in the Connecting the Input Signals
section. The SC-2345 connects the output signals of the first-stage SCC to
the inputs of the second-stage SCC. An example of dual-stage conditioning
is an SCC-ACCO1 followed by a lowpass filter module (SCC-LPXX).

Although not available for the SCC-ACCO01, sockets J9 to J16 are available
for digital input/output conditioning or control with another SCC module.
Refer to the SC-2345/2350 User Manual for more information on
configuring, connecting, and installing SCC modules.

Connecting the Input Signals

@ Note The signal names have changed. Refer to ni.com/info and enter rdtntg to
confirm the signal names.

Each screw terminal is labeled by pin number <1..4>. Pins 1 and 2 form a
differential (DIFF) analog input channel for measuring the voltage across
the accelerometer. This channel is routed to E Series DAQ device
channel X, where X is 0 to 7 depending on the socket where you plug in
the SCC-ACCOL. Pins 3 and 4 carry the 4 mA constant-current excitation
source. Figure 1 shows the SCC-ACCOL1 signal connections.
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Figure 1. SCC-ACCO1 Signal Connections

- NN W s

The signal source can be floating or ground-referenced. The SCC-ACCO1
input circuitry includes high-impedance bias resistors typically required for
floating sources. External bias resistors connected to ground are not
required.

For floating signal sources in high-noise environments, connect the
negative terminal of the signal source to the Al GND terminal on the
SC-2345 screw-terminal block to reduce common-mode noise.

For information about how to configure the SCC-ACCO1 module using
NI-DAQmx, refer to the SCC Quick Start Guide.

Using the SCC-ACCO1

Scaling Voltage Measurements

If you configured the SCC-ACCO1 using Measurement & Automation
Explorer (MAX) and are using NI-DAQ, the reading you get from the
E Series DAQ device is properly scaled. Use scaling constants obtained
from your sensor data sheet to convert the accelerometer voltage to the
desired unit, such as newtons, m/s?, or g. Otherwise, complete the
following steps to scale the readings:

1. Measure the accelerometer voltage.

a. Read the accelerometer channel on the E Series DAQ device
Veseries (CHX).

b. Calculate the accelerometer voltage using this formula:

Vacc = Veseries/2
where
Vacc is the SCC-ACCO1 input voltage.

Veseries 18 the E Series DAQ device input voltage.
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2. Ifthe module is configured using MAX, use scaling constants obtained
from your sensor data sheet to convert V, - voltage to the desired unit,
such as newtons, m/s2, or g.

@ Note Step 1 provides proper scaling for the amplifier in the SCC-ACCOI if the module is
not configured using MAX.

Specifications

These ratings are typical at 25 °C unless otherwise stated.

Analog Input

Number of input channels....................... 1 DIFF

Input range........ccceeveevveveeninieniieeens 5 V (fixed gain of 2)

Input coupling......ccccceveevenerneenceniencnnens AC (highpass 1-pole RC filter)
-3 dB cutoff frequency.................... 0.8 Hz

Filter tyPe...coveeeverieeienieeieeeeee e Lowpass 3-pole Bessel
—3 dB cutoff frequency........cc..c....... 19 kHz

Passband flatness ......ccceeeeveemeeeeeeeeeeeenen.n. +0.3 dB, 10 Hz-5 kHz;

*+1 dB, 5 Hz-10 kHz

Input impedance .........c.cceceevercveneniennenne 0.39 YF in series with 5 MQ
(powered on or off)

SYStEM NOTSE ..cvvvenvieiieriieeiierie e 130 UV s
(referred to input, [RTI])!

! This specification is calculated relative to the input range of the module.
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Transfer Characteristics

Gain transfer
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Phase transfer
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Galn eITOT .....oueeiieeeiereeieeeeceeereeaenne +1% of reading
Gain-error temperature coefficient......... +10 ppm/°C

OffSEt  ITOT ..o, +3 mV RTI

Offset-error temperature coefficient....... +1.6 uv/°C

NONINEATILY ..ot 10 ppm of full scale

Recommended warm-up time................. 5 min

Amplifier Characteristics

Common-mode rejection ratio................ 80 dB at 60 Hz

OULPUL TANEE ....eveeveeereeeeeere e +10V
Excitation

Number of channels...........c.ccc.coeevveeeennn. 1

Constant-current SOUICe .............coevvveeennn. 4 mA
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Maximum voltage level
without losing regulation

Temperature drift .........cccceceveeeienennnnne

Power Requirement

Physical

Field-wiring diameter

Maximum Working Voltage

Maximum working voltage refers to the
common-mode voltage.

Channel-to-earth (inputs)

Channel-to-channel (inputs)

Environmental

Operating temperature
Storage temperature

Relative humidity

© National Instruments Corporation

+127 ppm/°C

89 mW max
3 mA max

3 mA max

420 mW max
84 mA max

8.89cm x2.92 cm x 1.85 cm
(3.50in. X 1.15 in. X 0.73 in.)

28.6 g (1.0 02)
One 20-pin right-angle
male connector,

one 6-pin screw terminal

28 to 16 AWG

signal voltage plus the
42 VDC, 30 Vs

Installation Category I

42 VDC, 30 V
Installation Category 1

0to 50°C
—20to 70 °C

10 to 90%, noncondensing
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Maximum altitude...........cooovvvvvvvvnvnrnnnnens 2,000 m

Pollution Degree (indoor use only) ........ 2

Safety

This product is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:

» IEC61010-1, EN 61010-1
« UL3111-1, UL 6101B-1
 CAN/CSA C22.2 No. 1010.1

@ Note For UL and other safety certifications, refer to the product label or visit
ni.com/hardref.nsf, search by model number or product line, and click the
appropriate link in the Certification column.

Electromagnetic Compatibility

EmiSSionsS........ccoovvvivieiiiiiiiiieeeeeeeeeeeeen. EN 55011 Class A at 10 m
FCC Part 15A above 1 GHz

IMMUNILY oo, EN 61326:1997 + A2:2001,
Table 1

CE, C-Tick, and FCC Part 15 (Class A) Compliant

@ Note For EMC compliance, operate this device with shielded cabling.

CE Compliance
This product meets the essential requirements of applicable European
directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety).............. 73/23/EEC

Electromagnetic Compatibility
Directive (EMC) .....cccvverinininenieiecaens 89/336/EEC

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit
ni.com/hardref.nsf, search by model number or product line, and click the
appropriate link in the Certification column.
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SCC-ACCO1 Module Pin Assignments

Figure 2 shows the I/O connector pins on the bottom of the module.

/@
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Figure 2. SCC Module Bottom View

Table 1 lists the signal corresponding to each pin. Al (X) is an analog input
signal channel of the E Series DAQ device. AI GND is the analog input
ground signal and is the reference for Al (X). A GND is the reference for
the 15 V supplies and REF 5 V. AT GND and A GND connect to the
SC-2345 at the SCC-PWR connector. GND is the reference for the +5 V

supply.

Table 1. SCC-ACCO1 Module Pin Assignments

Pin Number Signal
1 E Series Al (X)
2 E Series Al GND
3 —
4 _
5 —
6 E Series Al GND
7 _
8 E Series AI GND
9 +5V
10 GND
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Table 1. SCC-ACCO1 Module Pin Assignments (Continued)

Pin Number

Signal

11

A GND

12

13

+15V

14

-15V

15

16

17

18

19

20

National Instruments™, NI™, ni.com™, and NI-DAQ™ are trademarks of National Instruments
Corporation. Product and company names mentioned herein are trademarks or trade names of their
respective companies. For patents covering National Instruments products, refer to the appropriate

location: Help»Patents in your software, the patents . txt file onyour CD, orni . com/patents.

© 2002-2004 National Instruments Corp. All rights reserved.

371070B-01 Mar04




	SCC-ACC01 Accelerometer Input Module User Guide
	Conventions
	What You Need to Get Started
	Device Specific Information
	Installing the Module
	Connecting the Input Signals
	Figure 1. SCC-ACC01 Signal Connections


	Using the SCC-ACC01
	Scaling Voltage Measurements

	Specifications
	Analog Input
	Transfer Characteristics
	Amplifier Characteristics
	Excitation
	Power Requirement
	Physical
	Maximum Working Voltage
	Environmental
	Safety
	Electromagnetic Compatibility
	CE Compliance

	SCC-ACC01 Module Pin Assignments
	Figure 2. SCC Module Bottom View
	Table 1. SCC-ACC01 Module Pin Assignments




